Report By Example Guide

Overview

Report by Example (RBE) extends the features of Query by Example (QBE) by adding some
formatting, grouping, and user defined calculation functionality. These tools provide a
fill-in-the-blanks interface which automatically generates a native query. There is no need to
become an expert in any of the various native querying language Qarbine supports. The core
features of the querying languages are supported. For more advanced queries, use the Data
Source Designer which is a free form query tool.

Prerequisites

Data service configured to access your data. In this example we will access the MongoDB
sample store sales data. It is best to have gone through the Quick Start - Query by Example
document.

Opening the Tool

You can access the Report By Example (RBE) tool in several ways. Tools can be opened from

the signOn page, the home page, and from various tools using the hamburger == menu. From
the Home tool.
Querying and Other Data Activities

7 Author or edit a data source to retrieve raw data using a query

l%' Open Query by Example for 'fill-in-the-blank' query interaction

| é' Open Report by Example for 'fill-in-the-blank' queries and basic formatting I

Alternatively you can open the tool from the hamburger == menu on each tool.

E @ Home

_@ Home

? Data Source Designer
,%, Query by Example (QBE)

Report by Example (RBE)




Pressing the control key during the menu click opens the tool in another tab.

Specifying the Data to Query

Select your data service from the dropdown. The Qarbine administrator manages which ones
are visible to any particular sign on.

[

{ Data service (1) Select data service v)

The databases associated with that data service will populate the database dropdown.

-

Database | 2) Select database

{ Data service | Sample Data Service W

The “database” concept varies by the actual cloud data endpoint being interacted with. For
example, MongoDB and SQL Server have this concept, while Milvus and Weaviate do not.

The collections associated with that database will populate the collections dropdown. Select the
collection as shown below. “Collections” is the generic Qarbine term. For SQL databases this
maps to “tables” for example.

Select a collection from the drop down.

Schema &FFJ nz:l} «

Collection [ 3) Select collection v

3) Select collection
Property i de ‘ ‘

The area below will show the general structure of the collection.

Property Include
¥ [.] sales
¢ _id
couponUsed
T purchaseMethod
saleDate
T storelocation
» customer
¥ [.] items
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At first the middle area will show some explanatory help information.




Report By Example

Feport by Example (REE) extends the features of Query by Example (QBE) by adding formatting, data grouping,
and calculation options. Qarbine generates both query and template for you. The result is a report based on the
retrieved data and template specification. You may optionally generate a Data Source or Template component for
further refinement. RBE provides a subset of formatting options available from the full featured Template
Designer. The general interaciion steps are:

1) Select the data service

2] Select the datahase

3) Select the collection

Once a field is chosen in the left hand area this middle area will be used to specify query
criteria, To see it again choose the Help tab as shown below.

Design Data Result Schema Analysis Help @ @

E:lo_ Table of Contents Report By Example

--|?] Cust rt inf ti
@ ustomer support information Report by Example (RBE) extends the features of Query by Example (QBE) by adding formatting,
@ Getting Started data grouping, and calculation options. Qarbine generates both query and template for you. The
result is a report based on the retrieved data and template specification. You may optionally
@ Home generate a Data Source or Template component for further refinement. RBE provides a subset of
.... Query by Example firmatting options available from the full featured Template Designer. The general interaction
steps are:
4 Report by Example 1) Select the data service
Calculati 2) Select the database
alculations 3) Select the collection

Specifying the Fields of Interest

Refer to the Quick Start- Query By Example document for the initial steps. The data service and
database area shown below.

( Data service | Sample Data Service v | Database | sample_supplies v |

The included fields are shown below.



Collection | sales v |

Property Include

¥ [.] sales
? _id
couponUsed
T purchaseMethod
saleDate
T storelLocation
¥ B customer
it age
T email
T gender
4t satisfaction
¥ [.] items

T name
1.2 price

3 quantity
¥ L.] tags

W <B<B<B<N<NER<NEE<R<B<JEAWEE

In this example start by limiting the results to sales in Denver. Simply enter “Denver” as shown
below.

storeLocation
Main criteria Denver

The right side is updated with the generated native query.

Also select saleDate and sort the orders by that field The query area looks something like the
following at this point.



sdles

storelL ocation saleDate
Main criteria Denver
Main sorting ascending
+
customer { } +
email satisfaction
Main criteria
Main sorting
s
items [] +
name price quantity
Main criteria
L L +

As fields are selected a rough rendering of the analysis template will be shown below the
generated query. An example is shown below.

1 Page header Page X of ¥ | |@runTimestamp |
1 Report header

1 Report header Sales in Denver |

1 Report header

1.1 Group header |Sale Date: |=@salesElement.saleDat|

1.1.1 Group header|Customer_|

1.1.1.1 Body |satisfaction:  |=#satisfact| |Email: |=#email
1.1.1.1 Body

1.2 Group header |Items |

1.2 Group header |HName |Price | quantity]

1.2.1 Body =#name |=#price | =#quantity|

1.2 Group summary

1 Report summary

The left hand outline looking text corresponds to the different sections and lines within those
sections. To the right of the vertical line are the cells which make up the template’s lines. The ‘#
prefix is used to reference a field (i.e., #email). The ‘@’ prefix is used to reference a variable
(i.e., @runTimestamp). These constructs will become more apparent when you use the
Template Designer which provides a rich set of reporting and analysis functionality.

Running the Query

Click the run button ﬁ to see your initial results.

Note that the active tab was changed to the “Result” tab as shown below.

Design Data Result Schema Analysis Help




To see the underlying data processed click the “Data” tab. This is the same information seen in
the Query by Example tool. A sample formatted result is shown below.

f® BB2 =l 7 KD

Page 1 of 7 12-Jan-2025 6:45:00 pm
Sales in Denver
Sale Date:  31-Dec-2012 11:28:58 pm
Customer
Satisfaction: 5 Email: onijorab@gi.hr
[tems
Name Price Quantity
pens 5.8 -
backpack 79.72 5
envelopes 23.25 1
envelopes 18.94 6
binder 22.61 5
printer paper 28.8 3
notepad 29.51 -
binder 22.19 6
laptop 1021.23 3
pens 37.24 4
Sale Date:  01-Jan-2013 3:27:40 pm
Customer
Satisfaction: 4 Email: ac@wital.so
[tems
Name Price Quantity
laptop 486.19 1
pens 57.01 5
envelopes 17.23 7
printer paper 39.56 6
binder 26.31 8
pens 43.12 2

We were able to very quickly obtain information from our NoSQL database data with embedded
document and arrays structures. The formatting is mostly raw values at this point.

Click the “Design” tab to get back to the query design content.

Design Data Result Schema Analysis Help




Default Generation Options

To view several default generation options click the ybutton to open the property dialog.
Activate the Options tab as shown below.

Properties
Main Options Prompt Formatting Page Setup Resources

Note- It is best to limit the elements returned using native query features like "limit"

Always Use Aggregate O

Form Grid Spacing |

Max Objects |25

One Heading Line Per Field O

Page # and run date (Page Header v
Place Breaks In Body For Single Group (]

Show ISO UTC dates instead of local dates (J

Skip jo

Title | My Report

Enter the new report title.

| ‘Title Sales in Denver ‘ |

Click OK to close the dialog.

Date Display and Maximum Element Retrieval Options

Note that the sample data above has sale dates stored as UTC dates. By default dates are

shown in the local timezone. To change this presentation click the ybutton to open the
property dialog.

Check the “ISO UTC” option as shown below.

Properties

Main Options Prompt Formatting Page Setup Resources About

| ‘ Show ISO UTC dates instead of local dates ‘ I

This dialog is also one way you can change the maximum number of elements in the answer set
you want processed.



Adding Formatting Adjustments

Suppress the store location output since we know this result is only for Denver.
Click the highlighted ‘+’ as shown below.

sales
storeLocation saleDate
Main criteria | Denver
Main sorting ascending
+

For the formatting options enter “suppress” as shown below.

sales

storelLocation

saleDate

Main criteria

Denver

Main sorting

ascending

Display as

Formatting

suppress

Grouping

Calculations

The customer email cell had a width of 20 which may be a bit too small. We can specify a larger
width by clicking the highlighted ‘+’ to see more options.

customer { } +

satisfaction email

Main criteria

Main sorting
+ |

Fill in the formatting criteria as shown below.

customer { } +
satisfaction email
Main criteria
Main sorting
Display as
Formatting width 30

We want to use currency formatting for the price. View the options by clicking the highlighted ‘+'.
items[] +

name price quantity

%in criteria
+

—



This can be done by simply typing in “currency” or by using the pop up menu sequence as
shown below.

items[] +
name price qua“tity

Main criteria

List criteria

List sorting

Display as

Formatting [ ]

Grouping Justification g

Calculations

L Font '

Data formatter general
Width <#> boolean
No Label csv

The cell gets filled in

‘ ‘ Formatting currency <template>

We'll use the default template. We also want to right-justify the prices. This can be set by
entering “right” into the formatting cell. Shown below is one result.

‘ HFormatting right currency default

Output from running this is shown below.



Sales in Denver

Sale Date:  31-Dec-2012 11:28:58 pm
Customer

Satisfaction: 5 Email:
ltems
Name Price Quantity
pens $5.80 4
backpack $79.72 5
envelopes $23.25 1
envelopes $18.94 6
binder $22.61 5
printer paper $28.80 3
notepad $29.51 4
binder $22.19 6
laptop $1,021.23 3
pens $37.24 4
Sale Date:  01-Jan-2013 3:27:40 pm
Customer

Satisfaction: - Email:
ltems
Name Price Quantity
laptop $486.19 1
pens $57.01 5
envelopes $17.23 7
printer paper $39.56 6
binder $26.31 8
pens $43.12 2

Adding Calculations

onijorab@gi.hr

ac@wital.so

It would be natural to want to know the number of separate product items, total number of items
and the overall value of each order. This can easily be added via the “Calculations” options

shown below.
items[] +

name

price quantity

Main criteria

List criteria

List sorting

Display as

Formatting

right currency default

Grouping

Calculations

count

sum




Next we can add an extended price calculation for each product.

Click on f +.
Sample entry values are shown below.

]

Path  [femg J
Alias [Value |
Result type | Number v|

| Expression|#price * #guantity |

| Ok Cancel

The overall settings for the items are shown below.
items[] +

name price quantity Value

Main criteria

List criteria

List sorting

Display as

Formatting right currency default integer
Grouping

Calculations |count sum

Running this results in the following.



Sales in Denver

Sale Date:  31-Dec-2012 11:28:58 pm

Customer
Satisfaction: 5 Email: onijorab@agi.hr
ltems
Name Price Quantity Value
pens $5.80 4 23.20
backpack $79.72 5 398.60
envelopes $23.25 1 23.25
envelopes $18.94 6 113.64
binder $22.61 5 113.05
printer paper $28.80 3 86.40
notepad $29.51 4 118.04
binder $22.19 6 133.14
laptop $1,021.23 3 3,063.69
pens $37.24 4 148.96
Count 10
Sum 41
Sale Date:  01-Jan-2013 3:27:40 pm
Customer
Satisfaction: 4 Email: ac@wital.so
ltems
Name Price Quantity Value
laptop $486.19 1 486.19
pens $57.01 5 285.05
envelopes $17.23 7 120.61
printer paper $39.56 6 237.36
binder $26.31 8 210.48
pens $43.12 2 86.24
Count 6
Sum 29

Notice the 2 new summary lines- one for the count and one for the summation.

Report By Example Control Breaks

Walk Through

The example reports below are strictly columnar for the purpose of this explanation.
“Control-breaks” are a way of grouping similar data objects together for analysis.

Consider a collection of animals (or perhaps sales objects with team and person fields). The
data used is from the following data service and database.

[ Data service | Sample Data Service v | Database|g_sample




The collection information is shown below.

Collection (animals v)

Property Include |
¥ [.] animals
? _id
1 age
[} born

T color
T name

T type

O00000

The user first selects the type, color, and name fields.

Property Include

¥ [.] animals
¢ _id O
it age O
born O
T color
T type

The criteria area has
' animals
type color name

Main criteria

Main sorting

+

The generated template looks like the following.

.1 Group summary
Report summary

1 Page header Page X of Y |@runTimestamp
1 Report header

1 Report header |Sales in Denver |

1 Report header

1.1 Group header |Type  |Color_ |Name |

1.1.1 Body =#type |=#color|=#name___|

1

1

Next, the user indicates the data should be sorted first by type and then, within each type, by
color.



animals

type color name
Main criteria
Main sorting | ascending ascending
+

D db.animals.find({},{ id: @, "type":1, "color™:1, "name":1}).sort({"type":1,"color":1}).limit(25)

The resulting very generic columnar report is shown below.

Design Data Result Schema Analysis Help
fe BBL el K<

-

Page 1 of 1 12-Jan-2025 7:06:32 prr
My Report

Type Color Name
cat brown  meower
cat brown  Kittycat
cat brown  mouser
cat grey kitty
dog black fido

dog black waldo
dog white

dolphin  grey flipper
fish orange

fish white betty
horse brown  pokey

Notice there are several types of animals. In a sales report data could have different sales
territories and then within each different salespersons.

Activate the tab shown below.

Design Data Result




Next, let’'s group the data based on the animal type. Click the highlighted ‘+’ to view the options.

animals

type color name
Main criteria
Main sorting | ascending ascending

+|

The first control-break is indicated by a ‘1’ below the field of interest. (This is a bit goofy Ul wise,

but for now....).

animals

type

color

name

Main criteria

Main sorting

ascending

ascending

Display as

Formatting

Grouping

Calculations

count

The generated template is shown below.

s

Page header
Report header
Report header
Report header
Group heade
Group heade
.1 Body
Group summa
Group summa
Report summar

I O T = R g
[ Y

r<Brk:
r<Brk:>

Page X of Y

|@runTimestamp

My Report |

| Type: |=@animal|

|Color  |Name

| =#color |=#name

ry<Brk>|Count_ |= count]|

ry<Brk>
y

Here is the result with each type creating a separate group.




My Report

Type: cat
Color Name
brown meower
brown  kittycat
brown mouser
grey kitty
Count 4
Type: dog
Color Name
black fido
black waldo
white
Count 3
Type: dolphin
Color Name
grey flipper
Count 1
Type: fish
Color Name
orange
white betty
Count 2
Type: horse
Color Name
brown pokey
Count 1

Notice there are also similar colors for some of the animals.



We can also indicate to perform a “control break” if either the type or color changes.

animals
type color name
Main criteria
Main sorting | ascending ascending
Display as
Formatting
Grouping 1 1
Calculations count

Here is the result for the 2 cat color groups.
My Report

Type: cat Color: brown
Name
meower
kittycat
mouser
Count Color: 3

Type: cat Color: grey
Name
kitty

Count Color: 1

For a strictly columnar result option the properties page and navigate to the tab shown below.

Properties

Main Options Prompt Formatting Page Setup Resources About

Choose the option below.

Place Breaks In Body For Single Group

Running now shows the following.



My Report

Type Color Name

cat brown meower

cat brown  Kittycat

cat brown mouser
Count 3

Type Color Name
cat grey kitty
Count 1

Other Grouping Options

The value for the grouping must at least specify the group number. If the field is date oriented,
then it may be followed by the keywords year, month or day indicating the granularity of the
break condition. This uses the dateProperty() macro function to extract the break field value.

To have groups start on new pages, append “pageBreakAfterlfMoreData” to the grouping
criteria. Prior to applying this the output may be



f® BB2 =l r KD

Page 1 of 1 12-Jan-2025 8:42:58 pm
My Report

Type Color Name

cat brown meower

cat brown  kittycat

cat brown  mouser

cat grey kitty
Count 4

Type Color Name

dog black  fido
dog black  waldo
dog white

Count 3

Type Color Name
dolphin  grey flipper
Count 1

Type Color Name

fish orange
fish white betty
Count 2

Type Color Name
horse brown pokey
Count 1

Adding that option to the type break is shown below.
animals

type color name

Main criteria

Main sorting | ascending ascending

Display as

Formatting

Grouping 1 pageBreakAfterlfMoreDat

Calculations count

The effect of this on the result is shown below.



Design Data Result Schema Analysis Help @
fe BB e s KA

s

Page 1 of 5 12-Jan-2025 8:40:25 pm
My Report

Type Color Name

cat brown  meower

cat brown  Kkittycat

cat brown  mouser

cat grey kitty
Count 4

Notice that there are now 5 pages of output- one for each type. This can be useful for
segregating sales team output by region for example.

Viewing Results

Result Navigation

A template’s formatting options indicate how to display the result.

Properties

Main Options Prompt Formatting Page Setup Resources About

. A
Cell Defaults
Font [Arial w12 v|
Make last page the first page ]

Display Options
Page By Page Navigation [Defer to preference (yes) |

Show Filler Lines | Defer to preference (yes) v

Show End Of Page Line [ Defer to preference (yes) |

Show Page Headers And
Footers | Defer to preference (yes) v |

The result toolbar includes information of how many total pages were generated. You may
choose to show all the pages at once or navigate them one by one. For example, for a 2 page
result this setting

Page By Page Navigation  (Yes v )




shows the following in the result toolbar

e 1 s K <KD D

and one page at a time is shown.

Alternatively this setting

Page By Page Navigation ~ [No v |

shows the following in the result toolbar
Page [ | Al 2

and all of the pages are shown.

Below is a table cross referencing the toolbar result page navigation icons.

Icon Description
H Go to the first page.
« Go to the previous page.
w Go to the next page.
DI Go to the last page.
Finding Text
The searching for text does span pages in the forward direction.
Icon Description
&ﬁ Find the first occurrence of the string starting on the current page.
& Find the next occurrence of the string.
b Y

Zooming In and Out

The result content may be zoomed in and out for your reviewing needs.



Icon

Description

Q

Zoom out.

Q

Reset the zoom to “none”.

O}

Zoom in.

Next Steps

Once you have a result you can then do other actions such as:

C

{:}

J50H

o

copy it to the clipboard in JSON format.

view the JSON in another window.

send it in various formats to a particular destination such as a download folder.
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